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The System 9000 setup utility is a software program designed for remote configuration of the RTK
Engineering rack based System 9000 annunciator.

The software can be used to configure the System 9000 from any PC running Windows 3.11 or later.
The user creates a database of settings for the rack which can be downloaded either immediately or at
a later date.  This means the whole system can be set up without a connection to the System 9000.  The
connection is only required for downloading settings made using the setup utility.

Additionally, as the rack also has a local setup card which can be used to modify the settings, the setup
software can be used to upload a rack configuration for analysis and storage.

The software contains many windows features which enhances its functionality and operation.  If you
are unfamiliar with basic windows operation please refer to the
windows basics chapter in your windows manual, before installing and using the
System 9000 setup utility.

1. Introduction
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Before installing the setup utility software, ensure that your hardware and system software meets the
following requirements.

Minimum:

•  386 or 486 PC; (486 DX2 66MHz recommended)

•  4Mb of RAM; (8Mb recommended)

•  10Mb of hard disk space

•   Microsoft ® Windows ™ 3.11 or later

•  1.44Mb 3.5" floppy disk drive

•  Spare serial port for communications with System 9000

2. System Requirements
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Depending on whether or not a serial connection with a System 9000 is established determines how a
new system database is created.  We will first consider a stand alone PC with no connection to the
System 9000.

From the File  menu select new,  the systems detail box, refer to later for more details on this form, will
be displayed.  Fill in the relevant details of each rack serial number, description, company and location
as required and press enter or click on the OK button with the mouse.

A prompt will now be displayed asking whether or not you want to find cards in the system
automatically, select  to continue as you do not have a connection to the System 9000.

At the next dialogue box enter the number of alarm cards you have in your system and wish to
configure, this may be any number from 1 to 200 alarm cards.

You are now ready to configure your system database.

Assuming a serial connection has already been established with a System 9000, refer to later for more
details on establishing a serial link, rack creating a new database is simple.  First select the New option
from the File menu and fill in the system details as described above.  At the following dialogue box enter
Yes to find cards in the system automatically.  You will then be prompted to enter the number of alarms
in your system.

The program will now search for installed alarm cards starting at card number 0 and going up to card
199.  When the correct number of cards have been found the search will be terminated and the user
notified of the number of cards found.  If the card search reaches 199 and all the cards have not been
found then the search will terminate and the user notified on the number of cards found.

If all cards have been found then you are ready to configure your system.  However if some of the cards
in your system were not detected you can add these cards manually using the Add Card option from the
Edit menu.  Alternatively if you wish to try and find these cards again select Find New Cards from the
Options menu and enter the remaining number of cards left to find.  If you still have problems
automatically finding new cards in the system refer to the chapter on Communications.

3. Creating a New System Database
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System Details

The System details form enables the user to enter details about the system for reference purposes The
rack serial number field is for the RTK serial number that is written on the side of the System 9000 rack
annunciator being configured.  The description field should be filled in to briefly describe  the system
settings being configured (for example test configuration, final commission etc.)
Company and location fields are available to give details on where the rack is installed.
These details are not required but help keep a complete record of the rack with the
configuration settings.
Additional information which can be obtained from the system details form, but which cannot be edited
by the user are:
The total number of cards available for configuration. The time and date of the last modification to
settings on any of the available cards, The time and date at which data was last uploaded or
downloaded to the rack.

Card Details

The card details form is used to describe details about the card and the channels associated with that
card.  The card and channel descriptions will then be shown on the main display when a specific card
is highlighted by the user.
It is also possible to renumber a card from the card details form. This is carried out by clicking on the
Modify Card Number button with the mouse, and entering the new number to correspond with the
Modbus address defined on the alarm card DIL switches in the System 9000, refer to the System 9000
handbook for further information on these DIL switch settings.
If the new number you have specified is currently in use by another card, the card will not be
renumbered.  In this situation the card already having the number you wish to use must either be deleted
or renumbered itself.

Adding Cards

Selecting the Add cards option from the edit menu will prompt the user to enter the number of cards to
be manually added to the database.  The total number of cards cannot exceed 200 so if a number too
large is entered with respect to the number of cards already in the
database an error message is displayed and no cards will be added.
To add cards automatically using the serial link connection to the System 9000 refer to the section on
finding new cards.

Deleting Cards

If you wish to delete a card from the database first highlight the card using the keyboard or mouse, and
then select the delete card option from the edit menu.
A dialogue box will appear where you can confirm the card number for deletion, following which the
card will be completely removed from the database.

4. Configuring a System Database
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Modifying Settings

The settings for the highlighted function are shown on the right hand side of the setup utility main
window.  These settings represent whether a function is turned on or off for each
individual channel.  If a function has an analogue value a text box will also be displayed showing what
this is currently set to.  If the channel setting is set a red indicator will be visible in the corresponding
check box while if the channel is not set (i.e. off) then there will be no indication in the corresponding
check box.
The channel settings can be modified by clicking on the check box using the mouse or moving to the
required check box using the TAB key, then pressing the space bar to toggle the channel on or off.
Turning off a channel with an analogue value will cause the analogue value to be reset to zero.
Pressing return after entering a new analogue setting, or clicking on another control using mouse, will
cause the program to carry out a range check on the value entered to ensure that it is between the
acceptable limits which are available for that function.  If the value is out of range the user will be
notified of the error and the channel will not be set.  Pressing return will also control the analogue input
box for the next channel.

Before any modifications to the database occur with regards to the channel settings for each function,
the changes have to be confirmed by the user.  This is done by pressing the commit button on the tool
bar.  Similarly, the abandon button is used to cancel any changes made on the display to the channel
settings.
When it is necessary to carry out a large number of modifications to the channel settings it may be
desirable to turn off the confirm changes feature.  This can be done by de-selecting the program auto
commit settings available from the options menu.  With confirm changes disabled confirm changes will
always be committed to the database when the card or function highlighted is moved to another card or
function.  Auto commit will also ensure that all channel settings have been committed to the database
before downloading or uploading any data.

If you have a connection between the PC and System 9000 and wish to make changes to the channel
settings directly to the corresponding channels in the System 9000, this is possible by selecting the auto
upload and auto download options in the program Settings.  Alternatively it is possible to upload the
entire rack system before carrying out any modifications and then only enable the auto download
feature to commit changes directly to the corresponding alarm card.

Any changes made to the channel settings will cause the modified flag of the corresponding card and
function to be set on the display.  This will make it easy to identify which functions from which cards
have been altered.  The modified flag can only be reset when a FIND function has been successfully
downloaded or uploaded.
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Find Cards

When the set up software is being run on a PC connected to a System 9000, the find button is used to
address cards in the rack to ensure that they are available.  When a link has been established with a
card the card has been found. There are three main Find options, these are described below.  Find can
be selected from the options menu or by pressing the find button on the toolbar. When a card is found
the issue of the software in the card will be displayed within the card list in the main window of the
setup utility software.  Other options available in the program settings allow found cards to have their
selected flag either set when found or reset when they cannot be found.  This may be useful on large
systems where you can view selected cards only.

Find System

Before carrying out the first download or upload after running the setup utility software it is useful to
carry out a find on the system to ensure communications can be established with every card.
The find system function will search the connected rack for all cards which have a corresponding entry
in the system database or the setup facility software.  Only cards that have had their number added to
the system database can be found using find system.

Find Highlighted

This function will search the connected System 9000 for only the card that is currently highlighted in the
card list on the setup utility main display window.

Find New Cards

If a new card has been added to the System 9000 rack, this must also be added to the system database
on the setup facility software.  This can be done off line (without a connection to the rack) using the Add
Card Function from the Edit menu, or alternatively it can be carried out on line (with a connection to the
rack) using the Find New Cards Function.

Selecting find new cards will prompt the user to enter the number of new cards to find in the connected
System 9000. The set up facility will then address all available cards (i.e. all card numbers between 0
and 999 not yet added to the database) until either it has found the correct number of cards, or reached
the limits of its range. All new cards that are found will then be added to the database included in the
card list on the display.

Uploading and Downloading

Channel settings can be uploaded from a connected System 9000 to the setup utility or downloaded
from the setup utility to the System 9000.  These functions are selected from the
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Options menu or by pressing the appropriate button on the toolbar.

Selecting Upload or Download will give the user a choice of options.  The list of options is identical for
both cards and functions and enables the user to set a filter which determines

which functions are downloaded or uploaded.

The download/upload options are as follows:

All - Set filter to download/upload

Modified - Set filter to download/upload only modified cards/functions

Selected - Set filter to download/upload only selected cards/functions

Highlighted - Download or upload only card function with current highlight.

If any error occurs during the request command (e.g. no reply, invalid communication packet etc.) a
message box will notify the user that an error has occurred and the user can then decide whether to
abort the whole communication request, retry the communication on that particular function or ignore
and move to the next function.
When a function has been successfully downloaded or uploaded its modified flag is reset.
The download option is protected from unauthorised users by a security password which must be
entered before a download can be carried out.  For more information refer to the section on Security.
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Communication Settings

The settings for serial communications between the PC and System 9000 rack are all available from the
Comms menu.

Read Timeout
The period of time in milliseconds that the set up utility software will wait after a Modbus read from the
System 9000. The default value for the read timeout is 40ms, but this will need to be increased if a lot of
read errors (i.e. upload and find cards commands occur).

Write Timeout
The period of time in milliseconds that the set up utility software will wait after performing a Modbus
write from the System 9000. The default value for the write timeout is 400ms. If errors constantly occur
during the download, increase this value to allow for a longer response time from the rack.

Number of Retry's
This is defined as the number of times the set up utility software will attempt a communication command
(Upload, Download or Find), with the System 9000 before displaying an error. The default value for the
number of retry's is 2, but this can be increased if consistent communication errors occur.  Note that
larger values for this setting can drastically slow down the find feature when the system is searching for
unavailable cards, however this should not be a problem in normal operation.

Port
All the communication port settings are configured from the port option in the comms menu. This allows
the user to modify values for baud rate and parity as well as define which comm port to use when
communicating with the System 9000. Values set in the port option must be identical to those set on the
System 9000 setup card for communications to be successful.

Note: The 9600 setting for baud rate is currently unavailable between the setup utility software and the
System 9000.
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The security option is available to prevent unauthorised users from downloading new configurations to
the System 9000 rack. This is disabled by entering a password which will then allow downloading to be
carried out, until the password protection is re-enabled.
The default password is 'password' which can be modified when the security has been disabled.  Valid
passwords can include alpha and numeric characters and be up to 20 characters long.
The options to disable/enable password protection are all available from the security menu.

5. Security



14

Open
Opens a previously saved database of System 9000 settings

Save 
Saves open database to disk under current filename.

Save As
Saves open database to disk under new filename

Repair Database  
Occasionally a database may become corrupt and create errors when trying to access data from the disk.
If this occurs then the repair database command should rectify any problems.
Note that this command cannot be carried out on an open database (i.e. one that is currently being
worked on)

Print Options  
Allows the user to set various print options which determine how the print function operates.
Note setting autosize on will ignore any printer font size that has  been defined.

Print 
Prints the settings of all functions or just selected cards and functions to the local printer.  Any changes
made to the printer setup will be made directly to the default windows settings.

6. File Menu
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View
This option controls which cards and functions are shown in the list boxes of the main setup utility
display window.
The various view options are:

Selected - Show only selected cards/functions
Modified - Show only modified cards/functions
Found    - Show only found cards

If all options are disabled then every available card/function in the database will
be displayed.

Refresh 
Fills in all data fields from database and redraws the display

Settings
Various program settings can be enabled from this option which determines how the program functions

Confirm changes
Determines whether the user has to manually confirm changes made to the channel settings before they
are committed to the database.  If this option is not enabled changes are automatically committed.

Select Cards When Found
Automatically selects cards in the database when they are found in a connected System 9000 rack.

De-select card when not found
Automatically de-selects cards in the database when they cannot be found in a connected System 9000
rack.

Automatic find and upload
This option will cause the setup utility software to automatically find a card and upload the function
settings from a connected System 9000 rack, when either the current card or function highlight is
moved.

Automatic download
Functionally the same as for automatic find and upload, but will automatically carry out a download
when the highlight is moved.

Save settings on exit
Enabling save settings on exit will cause the program settings (including communication and print
options) to be saved to the setup utility initialisation file such that these become the initial values the next
time the program is run.

7. Options Menu
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Selecting Cards and Functions

Cards and functions can be selected by choosing Select from the Edit menu.  This will display
 list boxes, one showing cards/functions available for selection and the other showing
cards/functions that are currently selected.  Select or De-select an individual item by highlighting
it with the mouse then using the Select/De-select buttons.
To select or de-select all the items use the Select All or De-select All buttons accordingly.

Alternatively cards and functions can be selected or de-selected from the setup utility main widow by
pressing the space bar on the highlighted card/function or double clicking with the mouse.
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8. Screen Layout


